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Installation 

  

Installing EasyView 

  

Any present version of EasyView must be uninstalled before installing a new version. 
Select Start -> Programs -> Ernitec -> EasyView -> Uninstall EasyView. 
  
Insert the EasyView labeled CD-ROM into your CD drive. If auto run is enabled, the installation 
program will start automatically. 
  
Alternatively, select Start -> Run, and type D:\Setup.exe (D, being your CD-ROM drive) 
  
The EasyView installation menu will appear. Click Next and follow the on-screen instructions to 
install EasyView. 
  
  

Hardware Security Dongle 

  

After installation of EasyView, plug the included USB Dongle into a free USB Port. The Dongle 
is a copy protection, and is required for full EasyView functionality. The number of cameras 
available is defined by the dongle. 
  
If the Found New Hardware Wizard pops up, select the option: Yes, this time only and click 
Next. 
  
On the next page select the option: Install the software automatically. 
  
If the Dongle driver is not found automatically, specify the file path 
\Ernitec\EasyView\Drivers\IWUSB.SYS if the “Program Files” directory manually. 
  
If started without a dongle, EasyView will start in Demo Mode which has limited functionality. 
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Getting started 

  
Select Start -> Programs -> Ernitec -> EasyView -> EasyView 

  

F1 Help 

  
Press [F1] key to get context sensitive help throughout EasyView. 
  

Log On 

  
At EasyView startup you will be presented to a Log On dialog. 
Enter the default User Name: EasyView and the Password: ****. 
  

 
  
You are now in Design Mode (blue background) where it is possible to configure EasyView. 
Start by adding a user with administrator rights. 
  

Add users 

  
Select the menu Wizard -> Users. It opens the EasyView user dialog. 
Add at least one user with Administrator rights. 
  

Save configuration file 

  
Select the menu File -> Save As and save the EasyView configuration under a given name. 
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Configuration 

  
The EasyView configuration can hold a large number of components used for video 
surveillance: 

•        Devices/Units 

•        Analogue and IP cameras 

•        Inputs/Outputs 

•        Alarm handling 

•        Macro handling 

•        Site map/floor plan 

•        Analogue monitors 

  
In the following some of the most common EasyView configurations will be explained in more 
details. You can skip the sections not applicable for your environment. 
  
  

DVR Configuration 

  
Select the menu Wizard -> DVR. It opens the DVR wizard. 
The DVR wizard is used to add, remove and modify DVR units, cameras, inputs and outputs to 
the EasyView configuration. 
  
Press [F1] key to get context sensitive help throughout the DVR wizard. 
  

•        Sites 
Add a site for each place where you have the DVR’s. A site groups one or several DVR’s 
and the attached cameras. 

•        DVR’s 
Select a site from the drop-list. Add the DVR’s connected to this site. Configure the DVR’s 
with name, IP address etc. 
Select another site and add the DVR’s connected to this other site etc. 

•        Cameras 
Select a DVR from the drop-list. 
Please note that only the DVR’s from the previous selected site are displayed. To 
configure DVR’s from other sites, click the Back button until you can select another 
site. 
Add and configure each camera with name, ID and camera type (FIX, PTZ) 

•        Inputs 
Select a DVR from the drop-list. 
Add and configure each input with name and ID 

•        Outputs 
Select a DVR from the drop-list. 
Add and configure each output with name and ID. 

  
  

NVR Configuration 

  
Select the menu Wizard -> NVR Camera Import. It opens the NVR wizard. 
The NVR wizard is used to add, remove and modify NVR units and cameras to the EasyView 
configuration. 
  
Press [F1] key to get context sensitive help throughout the NVR Camera Import wizard. 
  

•        NVR’s 
Add and configure the NVR’s with name, server type, IP address, user name and 
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password. 

•        Select a NVR from the drop-list and click Next to import the cameras from the NVR. 

•        Check the cameras that shall be imported. Configure the PTZ cameras with correct type 
and ID. 

  
  

System-X Configuration 

  
Select the menu Wizard -> SystemX import. It opens the System-X wizard. 
The System-X wizard is used to add, remove and update System-X units and cameras to the 
EasyView configuration. 
  
Press [F1] key to get context sensitive help throughout the SystemX import wizard. 
  

•        NodeManager export file 
Browse and select the previously made Node Manager export file. 

•        Enable the I151SX-PCIF devices that shall be imported and configure the COM port for 
each device. 

•        Save the configuration to an EasyView configuration file (normally placed under 
C:\Ernitec\EasyView\Databases\) 

  
  

Advanced Setup 

  
Select the menu View -> Advanced Setup. It opens the Advanced Setup dialog. 
The Advanced Setup dialog is used to add, remove and modify devices, cameras, inputs, 
outputs and analogue monitors in the EasyView configuration. This dialog is for EasyView 
experts and requires some prior EasyView experience. 
However this dialog may be the only way to handle certain devices not handled by the wizards. 
  

•        Connections 
Use this tab to add, delete or modify devices. The driver must be selected from the drop-
list and it must be configured. 

•        Cameras 
Use this tab to add, delete or modify cameras. A camera must be placed under a location. 
Under the camera-connection tab, right-click the device the camera is associated with. 
Under the camera-camera type tab, configure the camera. 

•        Input 
Use this tab to add, delete or modify inputs. An input must be placed under a location. 
Under the input-connection tab, right-click the device the input is associated with. Under 
the input-input config tab, configure the input. 

•        Output 
Use this tab to add, delete or modify outputs. An output must be placed under a location. 
Under the output-connection tab, right-click the device the output is associated with. 
Under the output-output config tab, configure the output. 

•        Monitors 
Use this tab to add, delete or modify analogue monitors. An analogue monitor must be 
placed under a location. Under the monitor-connection tab, right-click the device the 
analogue monitor is associated with. Under the monitor-monitor config tab, configure the 
analogue monitor. 

  

 

Page 5 of 60EasyView

19/09/2008file://C:\Documents and Settings\ste.ERNITEC\Local Settings\Temp\~hh8E5E.htm



Layout 

  
Select the menu Layout -> Show. You will now leave Design Mode and enter Layout Mode 
(green background). 
  
The layout mode defines the windows you want on the screen and where. Layout mode does 
not, like design mode, define the EasyView configuration/contents of the windows, only the 
layout. 
  

Close all windows (click on the icon ). Under the menu View you can select the windows you 
want. Select at least the windows: 

•        Splitscreen 

•        Camera List 
  
Press [F1] key to get more context sensitive help. 
  
Select the menu Layout -> Hide to leave Layout mode and enter Design Mode once again. 
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Operation mode 

  

Click on the icon   in the bottom panel. You will now leave Design Mode and enter 
Operational Mode. 
  
In operational mode you can see the camera video streams by drag/dropping the cameras from 
the camera list to the Split Screen. 
  
Press [F1] key to get more context sensitive help. 
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Technical specifications 

  

Compatibility 

  
EasyView is compatible with the following equipment: 

•        DigiOp DVR’s 

•        EDNS 2000 DVR 

•        Ernitec IP camera 

•        IP Ernitec NVR Basic 

•        IP Ernitec NVR Standard 

•        Ernitec Video Encoder 

•        System-X IP 

•        System-X RS232 (I151SX-PCIF) 

•        VB8000 Video Server 

•        W&T WEB-IO 

  
  

Computer/Network Requirements 

  
These are the Computer/Network requirements for the EasyView program. 

•        Intel Pentium 4 3.0 GHz 

•        Windows 2000/XP Operating System 

•        Graphic card 128 MB RAM 

•        PC Monitor capable of resolution 1280x1024 

•        1024 MB RAM, 2048 MB RAM recommended 

•        200 MB free Hard Disk space (depends on installation type) 

•        CD ROM Drive 

•        Free USB Port 

•        Windows compatible Pointing Device (Mouse) 

•        100 Mbits/s Ethernet IP Network 

  
  

Trademarks 

  
Echelon, LON and LONWORKS are trademarks of Echelon Corporation registered in the 
United States and other countries. 
  
All other brand and product names are trademarks of their respective companies. 
  
Advanced setup. 

In advanced setup the entire EasyView database is available for configuration. 

The configuration parts are divided into: 

λ Connections, to the devices  

λ Cameras  

λ Inputs  

λ Outputs  

λ Monitors  

λ Alarms  

Advanced setup of Connections 
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A connection represents a physical connection between EasyView and a device. 

A device may be a IP camera or a DVR/ NVR with a number of cameras connected to this device. Furthermore a device may be a 
bridge to another network topology, such as IP to LonWorks for the SystemX. 

 

A connection utilize an instance of a given driver type to make the interface between EasyView and the device. 

Use the  button to add a new connection. Select the type of driver to be used. 

Enable the connection, and select the "Can be used as stream". 

Enter the address, either the IP address or host name, for the device, and type the user name and password for a account on the 
device. 
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Use the  button to remove a connection. 

  

  

Advanced setup of Cameras 

A camera represents a physical camera or a video input channel on a DVR/ NVR. 

Add/ remove cameras: 

 

Use the  button to add a new location/ site to the configuration of cameras. 
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Use the  button to add a new camera to the location/ site. 

Use the  button to remove a camera from a location/ site. 

Use the  button to remove a location/ site and all the cameras within it. 

A connection must be assigned to the camera, and the camera must belong to a location/ site 

Use the  button to expand the collection tree view or the  button to collapse the collection tree view. 

Select the connection from the tree view by right-click on the item 

  

Location/ site Type: 

Default site number is 1, and default size is 1024. 

If EasyView is connected to SystemX the site number uniquely identifies the site, and the devices on the site. 

The site size is used when EasyView is connected to SystemX, and the total number of sites must be increased, and thus the number 
of devices per sites must be decreased. 

 

  

Cameras Type: 

The camera type have different attributes, such as Fix or PTZ, a control ID etc 
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IP cameras connected to a NVR have an additional camera IP address field. 

  

  

Advanced setup of Inputs 

Add/ remove inputs: 

An input represents a physical device input or an input on a DVR/ NVR. 
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Use the  button to add a new location/ site to the configuration of inputs. 

Use the  button to add a new input to the location/ site. 

Use the  button to remove a input from a location/ site. 

Use the  button to remove a location/ site and all the inputs within it. 

A connection must be assigned to the input, and the input must belong to a location/ site 
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Use the  button to expand the collection tree view or the  button to collapse the collection tree view. 

Select the connection from the tree view by right-click on the item 

  

Location/ site Type: 

Default site number is 1, and default size is 1024. 

If EasyView is connected to SystemX the site number uniquely identifies the site, and the devices on the site. 

The site size is used when EasyView is connected to SystemX, and the total number of sites must be increased, and thus the number 
of devices per sites must be decreased. 

 

  

Input type: 

The input type have different attributes, such as control ID, input pin, source type and input type. 
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The valid source types are: 

λ Input/Output for digital input devices  
λ Camera for IP cameras, video encoders and NVR´s  
λ DVR, for DVR's  

The valid input types are: 

λ Normal, for standard digital inputs  
λ MotionDetection, for motion detection events  

  

  

  

  

  

Advanced setup of Outputs 

Add/ remove outputs: 

An output represents a physical device output or an output on a DVR/ NVR. 
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Use the  button to add a new location/ site to the configuration of outputs. 

Use the  button to add a new output to the location/ site. 

Use the  button to remove a output from a location/ site. 

Use the  button to remove a location/ site and all the outputs within it. 

A connection must be assigned to the output, and the output must belong to a location/ site 
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Use the  button to expand the collection tree view or the  button to collapse the collection tree view. 

Select the connection from the tree view by right-click on the item 

  

Location/ site Type: 

Default site number is 1, and default size is 1024. 

If EasyView is connected to SystemX the site number uniquely identifies the site, and the devices on the site. 

The site size is used when EasyView is connected to SystemX, and the total number of sites must be increased, and thus the number 
of devices per sites must be decreased. 

 

  

Output type: 

The output type have different attributes, such as control ID, output pin and source type. 
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The valid source types are: 

λ Input/Output for digital input devices  
λ Camera for IP cameras, video encoders and NVR´s  
λ DVR, for DVR's  

  

Advanced setup of Monitors 

Add/ remove monitors: 

A monitor represents a physical monitor output of a matrix connected via SystemX to EasyView. 

The monitor is used on a monitor wall, which is a special map, containing only monitors. 
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Use the  button to add a new location/ site to the configuration of monitors. 

Use the  button to add a new monitor to the location/ site. 

Use the  button to remove a monitor from a location/ site. 

Use the  button to remove a location/ site and all the monitors within it. 

A connection must be assigned to the monitor, and the monitor must belong to a location/ site 
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Use the  button to expand the collection tree view or the  button to collapse the collection tree view. 

Select the connection from the tree view by right-click on the item 

  

Location/ site Type: 

Default site number is 1, and default size is 1024. 

If EasyView is connected to SystemX the site number uniquely identifies the site, and the devices on the site. 

The site size is used when EasyView is connected to SystemX, and the total number of sites must be increased, and thus the number 
of devices per sites must be decreased. 

 

  

Monitor type: 

The monitor type have only one attribute, the control ID. 
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Advanced setup of Alarms 

An alarm represents a handling of one of the inputs assigned to EasyView. 

Add/ remove  an alarm: 

Page 21 of 60EasyView

19/09/2008file://C:\Documents and Settings\ste.ERNITEC\Local Settings\Temp\~hh8E5E.htm



 

Use the button to add a new alarm to be handled. 

Use the button to remove an alarm. 

  

Select input source: 

Select the input from the tree view, by right-click on the item. The inputs in the list shown corresponds to the inputs defined. 

If the newest alarm is to be presented on the top of the alarm list, this check box must be checked. 

If the priority of the input source is to be used, as in case of SystemX inputs, this check box must be checked, otherwise a priority 
must be assigned 
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. 

Assign a handling: 

 

A map view may be assigned to the handling. 

The way the handling is cleared must be assigned to be either: 

λ When alarm is still active, that is the input is unchanged  
λ Manually by the operator or user  
λ When the alarm goes off, that is when the input is changed  
λ By timeout  

If the views is to be blanked when the alarm is cleared the check box "Dispose cameras" must be checked. 

The handling may be disabled by un-checking the "Handling enabled" check box. 

  

Assign an output: 
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Select the output by right click on an output in the tree view listing the valid outputs. 

Configure the output state when alarm is active. 

The valid actions for the output are: 

λ Follow the handling of the alarm  
λ Follow the alarm input  
λ Timed  

  

Assign  cameras: 
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Select the split format to be used in the action, that is the number of views to be used. 

Select a view. 

Select the camera to be shown in the view by right click on the camera in the tree view.  

Select a preset for the camera, provides it is a PTZ camera. 

EasyView Mode 

EasyView has 3 modes:  

Design Mode 
In Design Mode, the user configures and adds/removes devices, cameras, users, alarms, maps etc. 
The configuration is stored in an EasyView configuration file. 
Design Mode requires administrator rights. 

Layout Mode 
Layout Mode defines the EasyView windows that shall be present in Operational Mode, and where the EasyView windows shall be 
located on the monitor screen. 
The layout may contain EasyView windows like split screens, camera list, map view, alarm list etc. 
The layout is stored in an EasyView layout file. 
 
Layout Mode defines the layout of the EasyView windows only. 
Layout Mode does NOT define the EasyView configuration. This is done in Design Mode. 
Layout Mode requires administrator rights. 

Operator mode 
In Operational Mode the operator can view live cameras, view recordings etc. 

Design Mode 
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You are now in the Design mode 
 
The name of the present opened EasyView database is written in the title bar. 
The following describes the design mode menu system:  

File 
This menu contains the following submenus:  

λ New 
This submenu create a new, empty and nameless EasyView database. 
Please immediate give a name to the EasyView database using the SaveAs submenu.  

λ Open 
This submenu opens an uses an existing EasyView database file for the present EasyView configuration.  

λ Save 
This submenu saves all changes to the currently open EasyView database.  

λ SaveAs 
This submenu saves the EasyView database to a new file.  

λ LogOff 
This submenu opens the Log Off dialog box with options to Log Off EasyView, Exit EasyView or Cancel.  

λ Exit 
This submenu exits from EasyView.  

View 
This menu contains the following submenus:  

λ Map List 
The Map List maintains a list of bitmaps added by the user. 
Each bitmap can be used as the current selected Map View having camera, input and output icons etc.  

λ Alarm List 
The Alarm List maintains a list of alarm handlings defined by the user.  

λ Monitors 
This submenu handles the Monitor Map having analogue monitor icons defined by the user.  

λ Macro List 
The Macro List maintains a list of macro handlings defined by the user.  

λ Advanced Setup 
In Advanced Setup the user is able to control 
devices (connections), cameras, inputs, outputs, monitors and alarm handlings. 
This submenu is for the experienced user only.  

λ User log 
This submenu handles the user log.  

Wizard 
This menu contains a number of wizards making it simple for the user to configure EasyView. 
It has the following submenus:  

λ Alarm 
This submenu activates an Alarm wizard creating an alarm handling based on a defined input.  

λ Map View 
This submenu activates a Map View wizard adding a user defined bitmap to the Map List.  

λ Users 
This submenu activates a User wizard being able to create, remove and modify EasyView users.  

λ SystemX Import 
This submenu activates a SystemX import wizard being able to import 
SystemX devices, cameras, monitors, inputs and outputs to EasyView. 
The import is based on a Node Manager export file.  

λ DVR 
This submenu activates a DVR import wizard being able to create, remove and modify 
DVR devices, cameras, inputs and outputs in EasyView.  

λ InterVIEW Import 
This submenu activates an InterVIEW import wizard being able to import InterVIEW devices to EasyView.  

λ NVR Camera Import 
This submenu activates a NVR Camera Import wizard being able to create, remove and modify 
NVR devices and cameras in EasyView.  
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Layout 
This menu has the following submenu:  

λ Show 
This submenu leaves the design mode and switches to layout mode.  

λ Layout to use 
This submenu attach the layout file with the EasyView database. The attached layout file is shown on the right hand side of the 
status bar at the buttom.  

 

Tools 
This menu has submenus corresponding to the tools added to the \Tools directory under the EasyView application directory.  

Help 
This menu has the following submenu:  

λ About 
Gives the version number of EasyView and other relevant information.  

λ Getting started 
Opens the "Getting started" dialog.  

Bottom Menu 

 
 

Click on the  button to open the Log Off dialog box with the following options:  

λ Log Off EasyView  

λ Exit EasyView  

λ Cancel  

Click on the  button to leave design mode and to enter operational mode. 

Layout mode 

 

You are now in the Layout Mode. 
 
The Layout Mode defines the EasyView windows that shall be present in Operational Mode, and where the EasyView windows shall 
be located on the screen. 
You can add EasyView windows like split screens, camera list, map view, alarm list etc. 
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The layout is stored in an EasyView layout file. 
 
Note: 
Layout Mode defines the layout of the EasyView windows only. 
Layout Mode does NOT define the EasyView configuration. This is done in Design Mode. 
 
For more information on the three EasyView modes:  

λ Design Mode  

λ Layout Mode  

λ Operational Mode  

read the F1-help for the Design Mode. 

  

View menu  

 

 
 
To add a window to the EasyView layout, select the window type from the View menu. 
The following windows are available for the EasyView layout:  

λ Map List 
This will add a Map List to the layout. 
At maximum one Map List pr. layout is permitted.  

λ Alarm List 
This will add an Alarm List to the layout. 
At maximum one Alarm List pr. layout is permitted.  

λ Monitors 
This will add an analogue Monitor Map to the layout. 
At maximum one Monitor Map pr. layout is permitted.  

λ Camera List 
This will add a Camera List to the layout. 
At maximum one Camera List pr. layout is permitted.  

λ Output List 
This will add an Output List to the layout. 
At maximum one Output List pr. layout is permitted.  

λ Input List 
This will add an Input List to the layout. 
At maximum one Input List pr. layout is permitted.  

λ Split Screen 
This will add a Split Screen to the layout. 
Several Split Screens pr. layout are permitted.  

λ Map View 
This will add a Map View to the layout. 
At maximum one Map View pr. layout is permitted.  

λ Macro List 
This will add a Macro List to the layout. 
At maximum one Macro List pr. layout is permitted.  

λ Browser 
This will add a browser window to the layout.  

Remove a window from the layout 

To remove a window from the EasyView layout, click on the  button.  

Moving and resizing windows inside layout 
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Windows can be moved and resized the way you normally operates on Microsoft Windows. 
The contents of the windows, e.g. the bitmap of a Map View, 
sometimes causes a big system response time when windows are moved. 
Therefore it is possible to choice an option making only the borders of the windows visible. 
 
Right-clicking in the middle of a window gives the option to toggle Hide Control items On or Off. 
This has only effect in Layout Mode.  

  

PopUp windows  

 

 
 
By default, a window added in Layout Mode will be visible in Operational Mode. 
However some of the EasyView windows may be defined as PopUp windows. 
 
In Operational Mode, a PopUp window is invisible until the user right-clicks the top area of the monitor screen. 
This will display the list of available PopUp windows that can be opened by the user. 
 
In Layout Mode, right-clicking in the middle of a PopUp window gives the following options: 

λ PopUp 
This is a toggle option. When checked the corresponding window is defined as a PopUp window.  

λ PopUp location set 
When a PopUp window has been moved to its final place in the layout, 
select this submenu to save the location, where the PopUp window will show up in Operational Mode.  

  

Windows menu  

 

 
 
The Layout menu contains the following submenus:  

   

File menu  
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λ New 
This submenu create a new, empty EasyView layout. 
Please immediate give a name to the EasyView layout using the SaveAs submenu.  

λ Open 
This submenu opens and uses an existing EasyView layout file as the present EasyView layout.  

λ Save 
This submenu saves all changes to the present open EasyView layout file.  

λ SaveAs 
This submenu saves the EasyView layout to a new EasyView layout file.  

λ Exit 
This submenu leaves the Layout Mode and returns to Design Mode. 
Important: 
Leaving Layout Mode, saves a link in the present EasyView configuration file to the EasyView layout file.  

  

Status bar 

 

On the status bar the name of the layout file is shown. Also the coordinates of the window currently selected is shown. 

Operational Mode 

You are now in Operational Mode. Depending on the configuration, the operator can:  

λ View cameras  

λ View recordings  

λ Handle alarms  

λ Handle inputs/outputs  

λ Handle analogue camera/monitor cross points  

Top Menu 

 
 
Right-click the top area of the screen to activate the top menu. The top menu lists all the windows defined as pop up. 

Select a window to open it. When finished, click on the  button to close the window.  

To the right the current time is shown. 

 

Right-click on the time display to activate the tool menu. 
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Bottom Menu 

 
 

Click on the  button to open the Log Off dialog box with the following options:  

λ Log Off EasyView  

λ Exit EasyView  

λ Cancel  

Click on the  button to leave operational mode and to enter design mode. 

Split Screen 

This is the Split Screen help. 

 

An EasyView layout may have several split screens containing views. Each split screen can handle up to 16 digitized live or playback 
streams. 
The first split screen loaded is marked with a key-symbol in layout mode. 

The first view in this screen is selected by default at start up. Furthermore this first split screen is selected by the alarm handling. 

Optional text may be assigned to each split screen. 

  

Split Screen 
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This is the Split Screen help. 

 

An EasyView layout may have several split screens containing views. Each split screen can handle up to 16 digitized live or playback 
streams. 
The following defines the operations that can be performed on a split screen.  

Split screen formats 
From the grey panel on top of the split screen it is possible to select between 1, 4, 1 + 5, 1 + 7, 9 or 16-split format. 
If e.g. a 9-split format is selected, the first split screen group consists of the first 9 splits and the second split screen group consists of 
the remaining 7 splits. 
The page menu items is used to select  the groups, and the sub menu items below each of these items is used to select the group 
containing the camera by camera name.  

The group navigate keys    are used to select next/ previous group. 
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Live/Playback split 
A split can be used for digitized live or playback video streaming. 
When used for live, the split has a dark blue top bar. When used for playback, the split has a green top bar.  

Active split 
The active split is decorated with a yellow border. Single-click the top bar of a split to make this the active split. 

Video streaming in a split 
Live or playback video streaming in a split can be made several ways:  

λ Drag/Drop from camera list 
Drag a camera from the camera list and drop it in the selected split.  

λ Drag/Drop from map view 
Drag a camera from the map view and drop it in the selected split.  

λ Select camera 
The active split is used for video streaming.  

λ Alarm handling 
An alarm handling may start up to 16 video streams.  

λ Multi action 
A multi action may start up to 16 video streams.  

λ Macro 

Page 33 of 60EasyView

19/09/2008file://C:\Documents and Settings\ste.ERNITEC\Local Settings\Temp\~hh8E5E.htm



If a macro is running in the split, the macro may sequence between several camera streams.  

Starting a video stream in an already streaming split, will cause the split to close its present stream and start the new one. 

Single split menus 
When a split is used for live viewing or playback, the corresponding streaming menu can be reached in 2 ways: 

λ Press the  button on the top bar.  

λ Right-click the mouse button on the top bar.  

The following defines the streaming menu items. What menu items are available depends on the camera device. 
 
Live viewing menu: 

λ Camera Control 
The Camera Control takes care of all camera PTZ handling.  

λ Image Configuration 
The Image Configuration handles the parameters brightness, contrast, sharpness, hue and saturation.  

λ Stop Stream 
This menu stops the stream.  

λ Stream Configuration 
The Stream Configuration handles parameters like bit rate, resolution etc.  

λ Playback 
This menu converts the live viewing into a playback (if supported by the driver) for the selected camera. The menu has the 
following two options: 

ϒ By time 
The playback will start at a time selected by the user.  

ϒ Quick 
Depending on the driver, the playback will start 1 minute behind or at the last recording.  

Playback menu: 

λ Playback Control 
The Playback Control takes care of all playback options like snapshot, video clip etc.  

λ Stop Playback 
This menu stops the playback.  

λ Live 
This menu converts the playback into live viewing for the selected camera.  

Camera Control 
If the camera in a split is a PTZ camera, there are 3 ways to make PTZ in a split with a live video stream.  

λ Camera control dialog 

As described above it is possible to get a separate camera control dialog via the  button on the top bar.  

λ Split PTZ panels 
From the PTZ panels at the bottom of the split, it is possible to make the most common PTZ operations: 
Call Preset, Pan Left, Pan Right, Pan Up, Pan Down, Zoom In and Zoom Out. 
 

The  button is used to change between the panels.  

λ PTZ in split 
The camera will move based on where in the split (video stream) the mouse button is pressed. 
Pressing left in the split, the camera will move left etc. 
Some camera types may not support this functionality.  

Playback Control 
Having a playback in a split, there are 2 ways to make control it:  

λ Playback control dialog 

As described above it is possible to get a separate playback control dialog via the  button on the top bar.  

λ Split playback panels 
From the playback panels at the bottom of the split, it is possible to make the most common playback operations: 
Change time, Pause/Play, Single step forward/backward (in pause mode) and Fast forward/backward (in play mode). 
 

The  button is used to change between the panels. 
The recording time line displays the available recordings (if supported) for the selected day. 
Right-click the mouse button on the time line to switch between a 24-hour line and a 1-hour line. 
 
To change the playback time, click and hold the mouse button in the recording area. 
While moving the mouse button to the left or right, the time slider will display the actual new time. 
When satisfied, release the button at the selected new time.  
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Split screen menu 
Right-click the mouse button on the grey top bar of the split screen to get the split screen menu. 
The split screen menu applies to all video streams. 

λ Stop All Streams 
Stops the all video streams in the split screen.  

λ All Live 
Converts all playbacks into live video streams.  

λ All Playback 
Converts all live video streams into playbacks (if supported by the driver). 

ϒ Time adjust 
The playbacks will start at a time selected by the user.  

ϒ Quick 
Depending on the driver, the playbacks will start 1 minute behind or at the last recording.  

λ Set time on all playback streams 
Synchronize all playbacks to a time defined by the user.  

Split Maximize/Normalize 
The following describes the ways to maximize and normalize the whole split screen: 

Press the  button to maximize the whole split screen to full screen size. The present selected split format is not affected. 

Press the  button to return the whole split screen back to its original size and position. 
Double-clicking the grey top bar of the split screen will have same Maximize/Normalize effect as with the magnifier symbols. 
 
The following describes the way to maximize and normalize a single split: 
Double-click the top bar of a single split to maximize this split to full screen size. 
Regardless of previous settings, the split format will be changed to 1-split format. 
Double-click the top bar of the single split once again to return to the previous screen size, position and format.  

Wizards  

EasyView has wizards to easy the most common setup.  

The wizards include:  

Alarm 
This wizard is used to creating an alarm handling based on a defined input. 

Map View 
This wizard is used to create a map view. 

Users 
This wizard is used to add/ remove/ modify EasyView users. 

SystemX Import 
This wizard is used to import a System-X database file. 

DVR 

This wizard is used to create sites, and to add/ remove/ modify DVR's. 

InterVIEW Import         
This wizard is used to import an InterVIEW database. 

NVR 

This wizard is used to add/ remove NVR servers, and to import cameras from the NVR servers. 

User setup 

The user setup wizard is used to configure the valid users and their rights when using EasyView. 

User Setup 
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This is the User Setup dialog. This dialog adds and removes EasyView users. 

Add New User 
   

Press the    button to add a new EasyView user with default parameters. 
Information on  

λ Name 
The name of the EasyView user (login name).  

λ Password 
The password for the user name (login password).  

λ Priority 
The priority used in all actions or operations made this user. The smaller number the higher priority.  

λ User rights 
There are to kinds of EasyView users: 

ϒ Standard 
The standard user can use functions in operational mode only.  

ϒ Administrator 
The administrator has complete access to all functions in EasyView in design mode, layout mode and operational mode. 

λ User Access group 
The user must be assigned to a user right group to have access to the functions in operational mode.  

Remove User 
Select/Single-click on the EasyView user (e.g. in the Name field). 
  

Press the     button to remove the corresponding EasyView user from the list.  

  

User Access Group 

Press the    button to enter the user access group setup. 
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Add New User Access group 

Press the    button to add a new EasyView user access group with default no access rights. 

Check the functions to be granted access for, using the left-click of the mouse. 
  

Remove User Access group 
Select/Single-click on the EasyView user access group (e.g. in the Name field). 
  

Press the     button to remove the corresponding EasyView user access group from the list.  

  

User Access Granted 

The status bar at the bottom show the granted access rights of the current user, when the Finish button has been pressed. 

 

System-X Wizard 

The System-X wizard is used to import a System-X configuration file. 

The wizard includes: 

Import 

Import of the configuration file exported from the NodeManager. 

COM Port 

Assignment of the COM port to be used for the RS-232 connection to LonWorks. 

Database file 

The database file to be created or modified with the System-X import. 

System-X Import File Wizard page 
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This is the System-X Import File Wizard dialog. This dialog imports a System-X configuration to EasyView. 

Import file 
The System-X import to EasyView is based on a System-X export file generated by the Node Manager. 
Click on the Browse button to search for the Node Manager System-X export file. 
This file normally has the extension .mdb.SysX.Txt. 

Keep previous system X devices 
Checking this box keeps the System-X devices already configured in the EasyView database. 
Unchecking it removes all already configured System-X devices before importing the new ones.  

Site size 
The site size must be selected. The options are: 512 and 1024 (default).  

System-X Import PCIF Wizard page 

 

This is the System-X Import PCIF Wizard dialog. This dialog imports System-X PCIF devices to EasyView. 
The list shows the available devices. 

PCIF Import 
Each System-X PCIF device has the following parameters:  
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λ I151SX-PCIF Name 
The name of the PCIF device. This field is read-only.  

λ COM port 
The serial COM port on the EasyView PC where the PCIF device is connected. 
The COM port can be selected from drop-down list reflecting the available PC COM ports.  

λ Enable 
Select Yes to import the corresponding PCIF device. Select No not to import it.  

System-X Save File Wizard page 

 

This is the System-X Save File Wizard dialog, saving the System-X configuration to an EasyView database. 
Click on the Browse button to search for or create a new EasyView database. 
An EasyView database has the extension .evc. 
Click on the Finish button to save the database and to close the wizard.  

Map View Wizard  

The map view wizard has the following steps:  

Background image  

The background image used for the map view.  

Name  

The name of the map view.  

Items  

The items to be shown on the map view, and the actions assigned to the items. Mapview Wizard page  
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This is the Map View Setup dialog. 

Image File 
Click on the Browse button to search for a bitmap to be used as Map View. 
Available formats are: BMP and JPG.  

Preview 
The preview window shows the selected bitmap.  

Mapview Name Wizard page 

 

 

This is the Map View Setup dialog. 

Map Name 
The name for the bitmap will be displayed in the Map List.  

Mapview Items page 
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This is the Map View dialog. 
 
On the Map View it is possible to place icons representing the EasyView configuration: 
Fixed cameras, PTZ cameras, Outputs, Inputs, Alarm handlings, Multications and Navigations.  

Add icon 
An icon is added to the Map View by dragging it from the icon list at the bottom and dropping it at the desired place on the Map View.  

Delete icon 
Deleting an icon is done the stardard Microsoft way selecting the icon and pressing the Delete keyboard button.  

Resize icon 
Resizing an icon is done the standard Microsoft way to resize Microsoft windows.  

Overlapping icons 
See the section on Icon menu below.  

Configure icon 
Double-click the icon to open the property dialog and to configure the icon.  

Icon type 
There are several types of icons that can be placed on the Map View. 
The same icon type can be used more than once. 
 

 
This icon represents a fixed camera that can be used for live camera viewing. 
 

 
This icon represents a PTZ camera that can be used for live camera viewing. 
 

 
This icon reflects the On/Off status of a device output. 
 

 
This icon represents the On/Off status of a device input. 
 

 
This icon reflects the On/Off status of an alarm handling. 
 

 
This icon represents a multiaction. A multiaction defines a number of performed actions. These actions can be:  

λ View a number of cameras in the split screen  
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λ Set a number of outputs  

λ Change map view  

λ Play a sound  

λ Set a number of crosspoints between analogue cameras and analogue monitors  

 
This icon represents a navigation link to another Map View. 
 

Image 
Click the Image button to replace the present bitmap with another one. 
The Map View name and all defined, configured icons will remain unchanged.  

Icon menu 

 
It is possible to do certain actions on an icon by selecting it and Right-click the mouse button on the icon. 
This will bring up a menu. The following defines this menu:  

λ Send To Back 
This will send the icon to the back meaning that it will be hidden behind other overlapping icons.  

λ Bring To Front 
This will send the icon to the front meaning that it will be visible upon other overlapping icons.  

λ Default size 
This will reset the size of the icon to 50x50 px.  

λ Properties 
This will open the property dialog equal to a double-click on the icon.  

λ Delete 
This will delete the icon equal to pressing the Delete keyboard button.  

λ Copy 
This will copy the icon and its contents for a later Paste operation.  

Paste 

 
If a previous Copy has been on an icon, it is possible to paste it. 
Click on the Map View somewhere and Right-click the mouse button. 
Select the Paste submenu. This will paste the icon the selected place. 
Not all icons can be Copy-Pasted.  

Alarm Wizard 

This Alarm  Wizard is used to setup actions on alarm inputs. 

The configuration steps for each alarm input include: 

  

Alarm source 

The input which trigger the action. 

Cameras 

The cameras to be shown as video streams in a split view. 

Cross points 

The monitors to be used and the camera shown on each monitor. 

Outputs 
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The outputs to be activated. 

Map view 

The map view to be shown. 

Clearance 

The way the alarm is cleared. 

Alarm Source Wizard page 

 

This is the Alarm Source Wizard page. 

Alarm text 
The name of the alarm.  

Alarm source 
This defines the input source that will cause the alarm handling to start when the input becomes active. 
Click on the Source button to open and select an input from the input list.  

Alarm priority 
Check the Define priority box to select a user defined priority for the alarm. Priority 1 is highest. 
If the box is unchecked the priority from the input is used. Not all input types have a priority included. 
Alarms with the highest priority will be served first.  

Multi Action Camera Wizard 
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This is the Multi Action Camera Wizard page. 
This page adds and removes digitized cameras shown for the multi action.  

Split view format 
Click on the split screen icons to the left to select the format. 
It is possible to select between None, 1-split, 4-split, 9-split and 16-split. The split view list will reflect the chosen format.  

Camera 
Select/Single-click on the split view to be changed. 
Press the Camera button to open and select a digitized camera from the camera list. 
If the camera is a PTZ camera a preset call can be made too. Preset "0" or "--" means no preset.  

Clear 
Select/Single-click on the split view to be changed. 
Press the Clear button to remove the camera from the selected split view.  

Alarm Cross Point Wizard page 

 

This is the Alarm Cross Point Wizard page. 
This page adds and removes cross points between analogue cameras and analogue monitors to be executed for the alarm handling.  

Add 
Click on the Add button to add a new empty cross point to the cross point list.  
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Remove 
Select/Single-click on the cross point entry (e.g. the Monitor field) to be removed. 
Press the Remove button to remove the corresponding cross point entry from the list.  

Monitor 
Select/Single-click on the monitor field that shall be changed. 
Press the Monitor button to open and select an analogue monitor from the monitor list.  

Camera 
Select/Single-click on the camera field that shall be changed. 
Press the Camera button to open and select an analogue camera from the camera list. 
If the camera is a PTZ camera a preset call can be made too. Preset=0 means no preset.  

Alarm Output Wizard page 

 

This is the Alarm Output Wizard page. 
This page adds and removes outputs to be set for the alarm handling.  

Add 
Click on the Add button to add a new empty output to the output list.  

Remove 
Select/Single-click on an output in the list. 
Press the Remove button to remove the corresponding output from the list.  

Pin 
Select/Single-click on an output in the list. 
Press the Pin button to open and select an output from the output list.  

Options 
Select/Single-click on an output in the list. The following options for the output can be selected: 

λ None 
When selected, the output remains On even after the alarm has been cleared.  

λ Follow AlarmHandling 
When selected, the output goes Off when the alarm is cleared.  

λ Timed 
When selected, the output goes Off after a number of defined seconds.  

Alarm Map View Wizard page 
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This is the Alarm Map View Wizard page. 
This page changes Map View and plays a sound during the alarm handling.  

Map View 
During the alarm handling, a new bitmap from the Map List may be selected as the Map View. 
Select it from the drop-down list. A preview of the bitmap can be seen in the panel.  

Sound 
Check the Enable Sound box if a sound should be played during the alarm handling. 
There are the following options:  

λ General sound 
The sound "C:\Ernitec\EasyView\Sounds\Alarm.wav" is played.  

λ Specific sound 

Browse for a sound file to be played pressing the  button. 
The sound file is automatically copied to the directory "C:\Ernitec\EasyView\Sounds\".  

Alarm Clearance Wizard page 

 

This is the Alarm Clearance Wizard page. 
This page sets certain clearance parameters for the alarm handling.  
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λ Allow user to clear alarm 
Check this box if the user manually should be allowed to clear the alarm. 
If checked, it should be defined whether the alarm can be cleared even if the alarm source is still active.  

λ Follow the state of alarm source 
Check this box if the alarm should automatically be cleared when the alarm source is not longer active.  

λ Timeout 
Check this box if the alarm should be clear after a number of configurable seconds.  

λ Dispose cameras 
Check this box if the defined camera streams should be stopped when the alarm is cleared.  

DVR Wizard 

The setup a DVR includes: 

Site 

The site or location on which the DVR are placed. 

DVR configuration 

The configuration of the DVR assigned to the site. 

Cameras 

The cameras and the properties for the cameras to be used on the DVR. 

Inputs 

The inputs to be used on the DVR. 

Outputs 

The outputs to be used on the DVR. 

DVR Site Wizard page 

 

This is the DVR Site Wizard dialog. 
 
This dialog adds or removes sites. A site groups a number of cameras, input and outputs.  

Add 
Press the Add button to add a new location named "Site" to the Site List. 
The name of a site can be changed by normal text edit.  

Remove 
Select/Single-click on the site that shall be removed. 
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Press the Remove button to remove the corresponding site from the Site List.  

View config 

 
Press the View config button to show the current DVR configuration tree. 
The configuration tree is read-only.  

DVR Unit Wizard page 

 

This is the DVR Unit Wizard dialog. This dialog adds and removes DVR units. 

Select Site 
Before doing any Add or Remove, the site must be selected from the drop-down site list.  

Add 
Press the Add button to add a new DVR unit with default parameters. 
Information on  

λ DVR name 
Normal text field.  

λ DVR address 
Either the ip address or host name may be used.  

λ User name 
The user name shall reflect one of the user names configured in the DVR.  

λ User password 
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The password for the user name.  

λ DVR type 
There are 2 possible options: DigiOp DVR or EDNS2000.  

must be given. 

Remove 
Select/Single-click on the DVR unit (e.g. the DVR name) that shall be removed. 
Press the Remove button to remove the corresponding DVR unit from the DVR unit List.  

View config 

 
Press the View config button to show the current DVR configuration tree. 
The configuration tree is read-only.  

DVR Camera Wizard page 

 

This is the DVR Camera Wizard dialog. This dialog adds and removes DVR cameras. 

Select DVR 
First the actual DVR unit must be selected from the DVR unit list. 
Only the DVR units on the previous selected site are shown.  

Add 
Press the Add button to add a new DVR camera with default parameters. 
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Information on  

λ Camera Name 
Normal text field.  

λ Camera ID 
The Camera ID is the video input number on the DVR to which the camera is connected.  

λ Camera type 
There are 2 possible options: FIX or PTZ.  

must be given. 

Remove 
Select/Single-click on the DVR camera (e.g. the Camera Name) that shall be removed. 
Press the Remove button to remove the corresponding DVR camera from the DVR camera List.  

View config 

 
Press the View config button to show the current DVR configuration tree. 
The configuration tree is read-only.  

DVR Input Wizard page 

 

This is the DVR Input Wizard dialog. This dialog adds and removes DVR inputs. 

Select DVR 

Page 50 of 60EasyView

19/09/2008file://C:\Documents and Settings\ste.ERNITEC\Local Settings\Temp\~hh8E5E.htm



First the actual DVR unit must be selected from the DVR unit list. 
Only the DVR units on the previous selected site are shown.  

Add 
Press the Add button to add a new DVR input with default parameters. 
Information on  

λ Input Name 
Normal text field.  

λ Input ID 
The Input ID is the digital input number on the DVR.  

must be given. 

Remove 
Select/Single-click on the DVR input (e.g. the Input Name) that shall be removed. 
Press the Remove button to remove the corresponding DVR input from the DVR input List.  

View config 

 
Press the View config button to show the current DVR configuration tree. 
The configuration tree is read-only.  

DVR Output Wizard page 
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This is the DVR Output Wizard dialog. This dialog adds and removes DVR outputs. 

Select DVR 
First the actual DVR unit must be selected from the DVR unit list. 
Only the DVR units on the previous selected site are shown.  

Add 
Press the Add button to add a new DVR output with default parameters. 
Information on  

λ Output Name 
Normal text field.  

λ Output ID 
The Output ID is the digital output number on the DVR.  

must be given. 

Remove 
Select/Single-click on the DVR output (e.g. the Output Name) that shall be removed. 
Press the Remove button to remove the corresponding DVR output from the DVR output List.  

View config 

 
Press the View config button to show the current DVR configuration tree. 
The configuration tree is read-only.  

NVR Wizard 

The NVR wizard includes: 

Server 

Assignment of the NVR server. 

Cameras 

Import of the cameras assigned in the NVR server. 

NVR Server Wizard page 
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This is the NVR Server Wizard dialog. This dialog adds and removes NVR servers. 

Add 
Press the Add button to add a new NVR server with default parameters. 
Information on  

λ Name 
The name of the NVR server.  

λ Server type 
There are 2 possible options: IP EasyView NVR Basic or IP EasyView NVR Standard.  

λ Address 
Either the ip address or host name may be used.  

λ User name 
The user name and the password define the access to the NVR server.  

λ Password 
The password for the user name.  

must be given. 

Remove 
Select/Single-click on the NVR server (e.g. in the Name field) that shall be removed. 
Press the Remove button to remove the corresponding NVR server from the NVR server List.  

Import from server 
This field defines the NVR server from which a camera import should take place. 
The NVR server is selected from the drop-down list holding the defined NVR servers.  

NVR Camera Wizard page 
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This is the NVR Camera Wizard dialog. This dialog selects and configures NVR cameras. 

Select 
Select the NVR cameras that shall be imported, clicking the check box at each camera. 
The Select all button selects all NVR cameras and the Select none button unselect all NVR cameras.  

Configuration 
The NVR camera list holds the cameras defined in the selected NVR server. 
Each camera has the following information:  

λ Camera Name 
The name of the NVR camera. This field is read-only.  

λ IP address 
The IP address of the NVR camera. This field is read-only.  

λ Password 
The password for the user name. This field is read-only.  

λ User name 
The user name and the password define the access to the NVR server. This field is read-only.  

λ Type 
The type of the NVR camera (FIX or PTZ) must be selected. 
If the option PTZ is selected, the ID field can be changed too.  

λ ID 
The Camera ID used for PTZ control. 
If the selected NVR server is of type Ernitec NVR, the ID is the Camera ID set physically on the PTZ camera. 
In most cases the Camera ID=1. 
If the selected NVR server is of type TBD_NVR, the ID is the camera number inside the NVR server. 
In this case the ID should not normally be changed.  

λ Location 
The location under which the NVR camera shall be placed, must be selected.  

λ Video Encoder 
This field specifies whether the NVR camera is a Video Encoder or not. This field is read-only.  

Locations 
This opens a dialog where locations can be added or removed. 
Click the Add button to add a new location. Click the Remove button to remove a location.  

Map View List 

The map view list shows the map views defined. 

Map View List 
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This is the Map List dialog. 
The Map List maintains a list of bitmaps added by the user. 
On each bitmap the user can add icons representing 
cameras, inputs, outputs, monitors, alarm handlings etc. 
The present used/selected bitmap in Operational Mode is called the Map View. 
The following defines the possible actions:  

Add 
Click on the Add button to open the Map View wizard and to add a new bitmap to the Map List.  

Remove 
Single-click on/select a bitmap from the Map List. 
Click on the Remove button to remove the bitmap from the Map List.  

Default Map View 
To configure a bitmap as the default startup Map View in Operational Mode, 
Single-click on/select the bitmap from the Map List, 
and check the Use as Startup map  

Map View design 
Double-click on a bitmap to open it as a Map View. 
When opened, icons representing cameras, inputs, outputs, monitors etc. can be added to the bitmap.  

Macro 

A macro defines a number of cameras to be shown in a split view, for a period of time.  

The macro is defined in the macro list view. 

At runtime a macro may be started in the split view selected, using the runtime macro list view. 

  

Macro 

Macro List 

 

This is the Macro List dialog. 
The Macro List maintains a list of macros defined by the user. 
Each macro contains a sequence of actions as described in the section Macro Action Wizard. 
The Macro List defines the following actions:  

Add 
Click on the Add button to add a new, empty macro with a predefined name at the end of the Macro List.  
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Remove 
Single-click on/select a macro in the Macro List. 
Click on the Remove button to remove the macro from the Macro List.  

Edit 
Single-click on/select a macro in the Macro List. 
Click on the Edit button to open the Macro action dialog and edit the macro sequences. 
It is also possible to open the Macro action dialog by double-clicking a specific macro.  

Macro Action Wizard 

 

This is the Macro Action Wizard. This dialog handles the macro sequences in a specific macro. 

Name 
Enter a name for the macro.  

Add Camera 
This button adds a "Show Camera" sequence to the end of the Macro Sequence List. 
The camera is selected from the present camera list and a preposition can be called (if the camera is a PTZ camera)  

Add Delay 
This button adds a "Delay" sequence to the end of the Macro Sequence List. 
The delay is defined as a number of seconds.  

Add Pin 
This button adds a "Set output pin" sequence to the end of the Macro Sequence List. 
The output pin is selected from the present output list 
and it must be set to go On or Off.  

Refresh 
This button refreshes the Macro Sequence List.  

Remove 
Single-click on/select a sequence in the Macro Sequence List. 
Click on the Remove button to remove the sequence from the Macro Sequence List.  

Edit 
Single-click on/select a sequence in the Macro Sequence List. 
Click on the Edit button to edit the Camera, Delay or Pin sequence. 
It is also possible to edit the sequence by double-clicking it.  

Macro repeated 
If checked, the macro will start all over with the first macro sequence 
after having performed the last sequence in the Macro Sequence List. 
If not checked, the macro will stop after having performed the last sequence in the Macro Sequence List.  

Macro 
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This is the Macro Operational dialog used to Start or Stop macros. 

Start macro 
Single-click on/select a split window where to execute the macro. 
The selected split window is marked with a yellow border. 
Single-click on/select a macro and click the Start/Stop button. 
The macro should start executing in the split window and the state should change to Running.  

Stop macro 
Single-click on/select a running macro and click the Start/Stop button. 
The macro should stop executing and the state should change to Stopped.  

Alarm view 

The alarm view has three pages: 

Present alarms 

The current alarms in the alarm handling. 

Current log 

The alarms in the current log file. 

Alarm log 

The alarms in a selected log file. 

Alarm List 

 

This is the Alarm List. It contains all active alarms. 
 
All alarms in the list are prioritized having the alarm with the highest priority listed first. 
A new alarm will be placed in the list according to its priority. If the new alarm becomes the first alarm in the list, it will be executed. 
When an alarm is cleared, it is removed from this list and moved to the Alarm Log. If the cleared alarm was the first alarm in the list, 
the next alarm in the list will be executed. 
 
An alarm in the list contains the following information:  

λ Alarm Text 
The name of the alarm  
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λ Priority 
The priority of the alarm. The smaller number the higher priority.  

λ Location 
The location of the alarm source  

λ Time 
The time when the alarm became active.  

λ Clearance 
Not used by the alarm list.  

λ Live 
Always has the text "Live".  

λ Recorded 
Always has the text "Recorded".  

Clear 
Select/Single-click on an alarm in the list. Press the Clear button to manually clear the alarm. 
This is only possible if the Allow user to clear alarm box has been checked in the alarm configuration.  

Alarm handle test 
If defined by the alarm source driver, it is possible to simulate or test an alarm handling. 
Select an alarm handling from the drop list and press the Test button. 

Alarm Log 

 

This is the Alarm Log. 
The Alarm Log contains all alarms that have been cleared since the start of EasyView operational mode. 
 
An alarm in the log contains the following information:  

λ Alarm Text 
The name of the alarm  

λ Priority 
The priority of the alarm. The smaller number the higher priority.  

λ Location 
The location of the alarm source  

λ Time 
The start time when the alarm became active and the end time when the alarm was cleared.  

λ Clearance 
Defines how the alarm was cleared. The options are: 

ϒ User 
The alarm was cleared manually by the user.  

ϒ Input 
The alarm was cleared because of the alarm source (input) going Off.  

ϒ Timed 
The alarm was cleared due to a timeout  

λ Live 
Always has the text "Live".  

λ Recorded 
Always has the text "Recorded".  

File 
Use the menu items Save or Save As to save the present alarm log in a log file. 
If the log file should be visible for EasyView, the log file must be placed in the directory "C:\Ernitec\EasyView\Logs\Alarms\".  

Alternate menu 
Select/Single-click on an alarm in the list. 
Right-click the alarm to get access to the alternate menu containing the following options: 
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λ Live 
Start a live stream for the cameras included in the alarm handling for the alarm.  

λ Recorded 
Start a playback (if available) for the cameras included in the alarm handling for the alarm. 
The playbacks start at the time where the alarm was activated.  

Alarm Log Archive 

This is the Alarm Log Archive used to view saved alarm logs. 

File 

 

 
Use the file menu item Open to open the alarm log file dialog. 
All alarm logs for a given day is displayed in the list as the activation time for the first alarm in the log file. 
Select an activation time and press the OK button to open the corresponding log file. 
Alarm log files must be placed under the directory "C:\Ernitec\EasyView\Logs\Alarms\" to be visible for the dialog. 
 
Alternatively the user can press the Browse button to search for a specific alarm log file anywhere in the file system. 
 

 

 
An alarm in the log contains the following information:  

λ Alarm Text 
The name of the alarm  

λ Priority 
The priority of the alarm. The smaller number the higher priority.  

λ Location 
The location of the alarm source  
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λ Time 
The start time when the alarm became active and the end time when the alarm was cleared.  

λ Clearance 
Defines how the alarm was cleared. The options are: 

ϒ User 
The alarm was cleared manually by the user.  

ϒ Input 
The alarm was cleared because of the alarm source (input) going Off.  

ϒ Timed 
The alarm was cleared due to a timeout  

λ Live 
Always has the text "Live".  

λ Recorded 
Always has the text "Recorded".  

Alternate menu 
Select/Single-click on an alarm in the list. 
Right-click the alarm to get access to the alternate menu containing the following options: 

λ Live 
Start a live stream for the cameras included in the alarm handling for the alarm.  

λ Recorded 
Start a playback (if available) for the cameras included in the alarm handling for the alarm. 
The playbacks start at the time where the alarm was activated.  
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